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1. Welcome to TOPO! for ArcGIS 

 
Thank you for your interest in TOPO! for ArcGIS. Designed for the ArcGIS Enterprise Suite, this 
extension is compatible with ArcGIS 8.2 and higher, and is the premier topographic data set for 
the Geography Network. 
 
We hope you find this extension useful as well as easy to use. This User Guide is designed to 
provide installation instructions, an overview of the extension's key features, and enough 
information to get you started as quickly as possible. Please contact us for information about 
other digital map products that we carry. We also appreciate any feedback and suggestions you 
may have. 
 

About This Product 

The Fastest, Most Accurate Way to Add TOPO! Maps, DEMs and Hillshades to Your Projects 

TOPO! for ArcGIS is the only topographic map solution that integrates directly with ArcGIS. 
This extension adds a toolbar to ArcMap that directly accesses raster maps and data from the 
National Geographic TOPO! State CD-ROMs (sold separately). The toolbar also makes it easy to 
locate and manage maps and data in your project. With one click, you can select the maps and 
layer(s) you want and import them into your project as georeferenced data. Layers can be toggled 
on and off, and transparencies, color ramps, and visible scale ranges can be adjusted separately. 
Small file sizes make using TOPO! for ArcGIS fast and easy to use! 
 
Designed for ArcGIS, TOPO! for ArcGIS gives you professional-level graphics, using next-
generation DEM and topographic hillshade data. It’s all you need to ensure that your project is 
run smoothly, economically and efficiently. 
 

Getting More Help and Finding Out About Upgrades 

The best way to find out if there is a more current version of this software available, or to get 
answers to questions that are not addressed by this User Guide, is to visit us online at 
www.nationalgeographic.com/topo. You can also contact us by phone, mail, or email. 
 
Please refer to the last page of this guide to find out how to contact National Geographic Maps. 

http://www.nationalgeographic.com/topo
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2. TOPO! for ArcGIS License Agreement 
 
BY INSTALLING THIS SOFTWARE, YOU ACCEPT ALL THE TERMS AND CONDITIONS OF THIS 
AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT USE 
THE SOFTWARE. RETURN THE SOFTWARE TO THE PLACE WHERE YOU OBTAINED IT 
WITHIN 30 DAYS OF THE DATE OF PURCHASE FOR A FULL REFUND. 
 
1. Grant of License.  This Agreement permits you (“Licensee”) to use the enclosed copyrighted machine 
readable software program and associated data files that comprise TOPO! for ArcGIS© (“Software”) and 
the TOPO! for ArcGIS© User’s Guide (“Documentation”). This agreement permits you to use the Software 
to import and display National Geographic TOPO! maps and data into software produced by ESRI.  Any 
graphics file that is generated with the software will be referred to in this license as a “Reproduction.”  This 
Agreement is a license agreement and not a sale of a software product. The Software, Documentation, and 
Reproductions are furnished for your use and remain the property of National Geographic Maps. 
 
This Software is licensed to you to serve as a general reference for use in your home, business, or 
institution. The geographical data used in the Software are based on USGS topographic maps, USGS 
elevation data, and the USGS Geographic Names Information System. Please consider carefully the fact 
that the  Software and the geographic data may not be adequate for purposes requiring precision in 
depiction of geographic features, exact measurement of direction or distance, or for similar purposes 
including but not limited to navigation, tracking, or emergency response. 
 
This License grants you the right to use the Software on a single computer consisting of one central 
processing unit, one keyboard, and one display screen or on multiple computers in accordance with the 
number of licenses for which you have paid. You may not decompile, disassemble, or use any method to 
discover the trade secrets contained in the Software. You may not modify, adapt, translate, rent, lease, 
timeshare, or loan the Software.  You may copy elements of the Software onto the hard disk of your 
computer and load elements of the Software into RAM and the CPU of your computer. 
 
Please call or write National Geographic Maps for more details regarding network or site licenses, or if you 
wish to make the georeferenced map images created with this Software available to other users. 
 
You may transfer your rights under this Agreement by providing the recipient the Software and 
Documentation, provided that you retain no copies of the Software or Documentation and that the other 
party agrees to the terms of this License Agreement.  
 
2. Output Limitations.  This license grants you the right to create and reproduce an unlimited number of 
Reproductions for your personal, in-house business, or intra-institutional use including paper reports for 
distribution to co-workers, clients or colleagues subject to the property rights notice and credit requirements 
set forth below. We ask that the National Geographic copyright notices appear in legible form on or 
adjacent to the reproduction in the following form: 
  
“Created with TOPO!, ©2003 National Geographic Maps, All Rights Reserved” 
 
You may distribute Reproductions on paper, as long as the Reproductions are distributed freely, without 
charge and the National Geographic copyright notice appears in legible form or National Geographic is 
given legible credit as described in paragraph 1 of the output limitations section. 
 
We ask that you obtain a supplementary license in writing from National Geographic before you reproduce 
and distribute any Reproductions over the Internet or other electronic networks, or in a publication that is 
for sale, resale, or that contains paid advertisement. In most cases this license is available free of charge.  
 
Please call, write, or e-mail National Geographic Maps for more details about extended use licenses at: 

(800) 962-1643  
topo@ngs.org 
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National Geographic Maps - TOPO! 
375 Alabama Street, Suite 400 
San Francisco CA, 94110 

 
3. Property Rights.  The Software, Documentation, and all Reproductions are owned and copyrighted by 
National Geographic Maps with all rights reserved. You may make one copy of the Software for backup 
purposes. The Software represents and embodies trade secrets of National Geographic Maps and/or its  
licensors. These trade secrets are not licensed to you, and any modification, addition, or deletion is 
prohibited. You agree to take all reasonable steps to protect the Software from unauthorized copying or use. 
 
4. Term.  This License is effective until terminated.  This License and your right to use the Software 
terminate automatically if you violate any part of this agreement. Should the Agreement be terminated, you 
agree to return all copies of the Software, Documentation, and Reproductions furnished to you, or made by 
you, and all copies to National Geographic Maps, including copies resident in the computer’s memory. 
 
5. U.S. Government Restricted Rights.  If this Software is acquired by or on behalf of any unit or agency of 
the United States Government, this provision applies. This Software (a) was developed at private expense, 
and no part of the software application was developed with government funds, (b) is a National Geographic 
Maps trade secret for all purposes of the Freedom of Information Act, (c) is restricted computer software 
submitted with restricted rights in accordance with 52.227-19 (a) through (d) of the Commercial Computer 
Software Restricted Rights Clause and successors, (d) in all respects is proprietary data belonging solely to 
National Geographic Maps, and (e) is published and all rights are reserved under the copyright laws of the 
United States. For units of the Department of Defense (DOD), this Software is licensed only with 
Restricted Rights as that term is defined in the DOD Supplement to the Federal Acquisition Regulations, 
52.227-7013 (c) (1) (iii) and its successors. Use, duplication, or disclosure of the Software by the 
Government is subject to restrictions as set forth in subdivision (b)(3)((ii) of the Rights in Technical Data 
and Computer Software clause at 252.227-7013 of the DOD FAR. Contractor/manufacturer is NG TOPO, 
375 Alabama Street, Suite 400, San Francisco, CA 94110. 
 
6. Export Laws.  Licensee understands that the product may require a license from the U.S. Department of 
Commerce or other government agency before it may be taken or sent outside of the United States. 
Licensee agrees to obtain any required license before taking or sending the Software outside the United 
States. Licensee will not permit the export or re-export of the Software without obtaining required licenses 
of letters of further assurance. 
 
7. Governing Law.  This agreement will be governed by, and interpreted in accordance with; the laws of the 
State of California of the United States of America as applied to transactions entirely within California 
between California residents. 
 
8. Entire Agreement.  This agreement sets forth the entire understanding and agreement between National 
Geographic Maps and you, and may be amended only in a writing signed by both parties. NO VENDOR, 
DISTRIBUTOR, DEALER, RETAILER, SALES PERSON, OR OTHER PERSON IS AUTHORIZED TO 
MODIFY THIS AGREEMENT OR TO MAKE ANY WARRANTY, REPRESENTATION, OR 
PROMISE WHICH IS DIFFERENT THAN, OR IN ADDITION TO, THE REPRESENTATIONS OR 
PROMISES OF THIS AGREEMENT. 
 
9. Waiver.  No waiver of any right under this agreement will be effective unless contained in writing, 
signed by a duly authorized representative of National Geographic Maps, and no waiver of any past or 
present right arising from any breach or failure to perform will waive any future right arising under this 
agreement. 
 
10. Severability.  If any provision in this agreement is invalid or unenforceable, that provision will be 
interpreted, limited, modified, or, if necessary, severed, to the extent necessary, to eliminate its invalidity or  
unenforceability, and the other provisions of this agreement will remain unaffected. 
 
Limited Warranty and Warranty Disclaimer 
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1. Limited Warranty and Warranty Disclaimer. National Geographic Maps warrants the disk on which the 
Software is to be distributed to be free from defects in materials and workmanship and that the unaltered 
Software will perform substantially in accordance with the documentation for a period of 90 days from the 
date you purchased the license to the Software. Any written or oral information, or advice given by 
National Geographic Maps’ dealers, distributors, or employees will in no way increase the scope of this 
warranty.  
 
National Geographic Maps makes no other warranties, express or implied, including, without limitation, the 
implied fitness for a particular purpose, regarding the Software. National Geographic Maps does not 
warrant, guarantee or make any representations regarding the use or the results of the use of the Software in 
terms of its correctness, accuracy, reliability, currency or otherwise. You assume the entire risk as to the 
results and performance of the Software. 
 
THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHT. YOU MAY HAVE OTHERS, 
WHICH VARY FROM JURISDICTION TO JURISDICTION.  
 
NATIONAL GEOGRAPHIC MAPS IS IN NO WAY RESPONSIBLE FOR PERSONAL INJURY OR 
DAMAGE TO PROPERTY IN CONNECTION WITH THE USE OF ITS SOFTWARE OR 
GEOGRAPHICAL DATA.  IN NO EVENT WILL NATIONAL GEOGRAPHIC MAPS, AND ITS 
DIRECTORS, OFFICERS, OR EMPLOYEES BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, 
INCIDENTAL OR INDIRECT DAMAGES (INCLUDING BUT NOT LIMITED TO DAMAGES FOR 
LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, AND LOSS OF BUSINESS 
INFORMATION) ARISING FROM THE USE OR THE INABILITY TO USE THE SOFTWARE, AND 
THE ACCOMPANYING WRITTEN MATERIALS. 
 
2. Exclusive Remedy.  Your exclusive remedy, as well as National Geographic Maps and its suppliers 
entire liability arising from, or in connection with the Software, Documentation, Reproduction and/or this 
License, will be the refund of the license fees, or the replacement of defective components of the Software. 
In no event will National Geographic Maps’ total liability for any damages, direct or indirect, in connection 
with the product, the product documentation, and/or this License exceed the license fees paid for your right 
to use this copy of the product whether such liability arises from any claim based upon contract, warranty, 
tort or otherwise. 
 
 
©2003 National Geographic Maps. All Rights Reserved.   
TOPO! is a registered trademark of National Geographic Holdings. 
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3. System Requirements 
 
 

TOPO! for ArcGIS is an extension that adds new functionality to ESRI software for Windows 
PCs. It works with ArcGIS versions 8.2 and later. 

In order to use TOPO! for ArcGIS you must have: 

• an IBM PC or equivalent computer 
• Windows 95 or higher (ArcGIS currently requires Windows 2000, XP or NT 4.0) 
• At least 24 MB RAM 
• Color monitor (256 colors or better) 
• CD-ROM drive (2x or faster) 

Additional Requirements: 
 
• ArcGIS 8.2 or higher 
• TOPO! State Series CD-ROMs (sold separately -- visit www.nationalgeographic.com/topo) 

http://www.nationalgeographic.com/topo
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4. Installation Instructions 

 
Installing TOPO! for ArcGIS 
 
Use the installer application (setup.exe) to install the extension and other files that TOPO! for 
ArcGIS requires onto your hard drive. Follow these steps: 
 
1. Insert the TOPO! for ArcGIS CD-ROM 
2. Choose the “Run” command from the Start Menu 
3. Type “D:\setup.exe” (If your CD-ROM is not drive D: substitute the correct drive letter in 
place of “D” ) 
4. Click “OK” and follow the instructions on the screen 
5. Activate the extension from ArcMap (see instructions below) 
 
NOTE: ArcGIS must already be installed on your PC or you will not be able to complete the 
installation of this extension. 
 
Activating the TOPO! for ArcGIS Extension in ArcMap 
 
To use this extension and its toolbar, you may need to turn it on. Follow these steps: 
 
1. Launch the ArcMap application 
2. Choose Extensions… from the Tools menu in ArcMap 
3. Check the box next to TOPO! for ArcGIS and click OK 
4. Choose the Toolbars sub-menu from the View menu in ArcMap 
5. Check the box next to TOPO! for ArcGIS to toggle the Toolbar on 
 
Optional: Loading TOPO! data CD-ROMs onto a local or network drive 
 
If you plan to use this extension frequently, you may want to load one or more of the data CD-
ROMs that came with the TOPO! State Series product you purchased onto your hard drive. This 
will give you faster and easier access to the topographic maps, but is not required - the extension 
can display data directly from the TOPO! CD-ROMs if you prefer. To copy a CD-ROM to a local 
or network drive, follow these steps: 
 
1. Decide which TOPO! State Series CD-ROMs you wish to copy to your hard drive. The back 

of the CD-ROM pack has an index map showing which portions of the state are on each CD. 

2. Insert one of the CDs you want to copy into your CD-ROM drive and view its contents. 

3. If you have more than one hard drive, decide which one you want to place the data on. You 
will need approximately 600 MB (i.e. 0.6 GB) of drive space per CD-ROM. 

4. Copy the entire directory that is on the CD (named something like "CA_D02") to the root 
level of your hard drive (i.e. directly to the drive - not into another subdirectory). 

5. Repeat steps 2 thru 4 for any other TOPO! data CD-ROMs you want on the hard drive. 

6. If you want to make this data available over a network, you will now need to locate this hard 
drive from each client PC, right-click its icon, and choose Map Network Drive… 

(NOTE: This requires a Multi-User Network License from National Geographic Maps) 
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5. Using TOPO! for ArcGIS 
 

Getting Started 

To use this extension, you first need to install it and turn it on in ArcMap. See section 4 above for 
installation instructions. 

Once the TOPO! for ArcGIS extension is enabled, you will have access to a new toolbar when 
you are working with a Data Frame in ArcMap. This toolbar has been designed to make it easy to 
create a base map that includes separate layers for the topographic map, the hillshade, and the 
elevation data. 

The section on the following page gives a good introduction to this new toolbar. Even if you 
don’t plan to follow along with the step-by-step tutorial, reading through that section may help 
you to get started with your own project. 

 

About the Maps and Data 

The maps on the TOPO! CD-ROMs are stored in a proprietary format called ".tpq" files. They 
have been created by National Geographic Maps from the most current USGS paper maps and 
digital elevation data available. True 24-bit color imaging and pixel-accurate georeferencing 
make these maps ideally suited as background imagery in a wide range of GIS applications. 

The TOPO! for ArcGIS extension includes software that allows ArcGIS to treat this .tpq format 
just like any other raster image format, such as .tif or .jpg. The extension also enables you to 
access the 3 layers in the .tpq files as separate layers, giving you independent access to the 
topographic map, the hillshade, and the DEM elevation data. 

The DEM information has been compiled from the 1 arc-second USGS NED dataset. This dataset 
was an improvement on the 30m DEMs, as it corrected numerous problem areas and filled in 
missing holes of data, while maintaining the same level of detail and accuracy. The hillshade 
layer was created by National Geographic Maps from this same elevation data. 

NOTE: The TOPO! maps and data in the .tpq format are stored unprojected. If the data in your 
Data Frame is projected, the base maps will be reprojected to the same projection as the first 
Layer when they are being displayed by ArcMap. 
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Step-by-Step Tutorial Using Sample Data  

1. Creating a set of layers with TOPO! data starts by identifying the right TOPO! CD-ROM. If 
you want to try the extension with some sample maps and data, leave the CD-ROM you used 
to install TOPO! for ArcGIS in your drive. If you want to view maps of a particular area, use 
the index map on the back of the wallet that contains your TOPO! CD-ROMs to determine 
which CD-ROM to load in your drive. 

2. Open the sample file called “Rainier.mxd” in ArcMap. This file is located in a directory 
called “Tutorial” on the TOPO! for ArcGIS CD-ROM, and contains some sample shape files 
for Mount Rainier National Park. If you cannot locate the “Rainier.mxd” document, run 
ArcMap and start a new empty map document instead. 

3. Open the ‘TOPO! for ArcGIS’ Toolbar (see section 4 for help). 

4. Click on the pull-down menu called “TOPO! for ArcGIS” on this toolbar and choose the item 
called “New TOPO! 24K Layer…” (or, if you prefer to view USGS 100K maps, choose the 
item called “New TOPO! 100K Layer…”). 

5. If instructed to choose a directory for TOPO! metadata files, choose a location on your hard 
drive that you would like to use for TOPO! layers, projection information, and any “raster 
pyramids” that ArcGIS might build for these layers (see ArcGIS documentation to learn more 
about metadata and/or pyramids). The pyramids are the only files that will consume 
significant amounts of disk space (roughly 2 MB per 7.5’ map). 

6. When asked for a name for this TOPO! Group Layer, just click “OK” to accept the default. 

7. You should now be in “Edit Mode” for this TOPO! layer. When in Edit Mode, each TOPO! 
map that is currently accessible will be represented as a rectangle. Grey rectangles represent 
maps that are not in the TOPO! layer, and red rectangles represent maps that are in the layer. 

If you do not see any rectangles in the Data Frame window but do have a TOPO! CD-
ROM in your drive, try choosing the item called “Zoom to Extent of Available TOPO! 
Maps” from the ‘TOPO! for ArcGIS’ menu. 

8. New layers start out empty, with no maps in them. Try adding a map to the layer by clicking 
on one of the grey rectangles with the ‘Add Maps’ tool from the ‘TOPO! for ArcGIS’ 
Toolbar (this tool has an arrow with a + sign next to it).  

 If the rectangles are very small, you may wish to zoom in closer before choosing a map. 

9. The grey rectangle you clicked on should now be red, indicating that this map is now part of 
your TOPO! layer. 

10. Click on the pull-down menu called “Editor” on the toolbar and choose the item called “Stop 
Editing”. 

11. When asked if you want to “Save Edits?”, click “Yes”. 

12. The map you toggled on in step 8 should now appear in the Data Frame, with the TOPO! 
map, hillshade, and DEM appearing on 3 separate layers. Try toggling layers on and off and 
experimenting with display properties such as “transparency” and “color ramp” (see ArcGIS 
documentation for help). 

13. To add more maps to this layer, or to remove maps from it, click on the pull-down menu 
called “Editor” on the toolbar and choose the item called “Start Editing” to return to Edit 
Mode. 
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Understanding the 'TOPO! for ArcGIS' Toolbar 

The previous section gives an overview of the steps necessary to create a TOPO! layer in 
ArcMap. This section describes the function of each menu item and button on the “TOPO! for 
ArcGIS” toolbar. 

Items on the pull-down menu called “TOPO! for ArcGIS”: 

1. “New TOPO! 24K Layer…” 

Choose this item to create a new group layer of TOPO! data using the most detailed 
USGS 7.5’ maps (1:24,000 scale). Before choosing this, insert the TOPO! CD-ROM for 
the area of interest in your CD drive (or, load one or more CD data folders on your hard 
drive – see section 4 for more details). You will be asked to name this group layer, and 
then you will be put into “Edit Mode” (see the item below called “Start Editing…”). 

2. “New TOPO! 100K Layer…” 

Choose this item to create a new group layer of TOPO! data using less detailed USGS 
maps (1:100,000 scale). Before choosing this, insert the TOPO! CD-ROM for the area of 
interest in your CD drive (or, load one or more CD data folders on your hard drive – see 
section 4 for more details). You will be asked to name this group layer, and then you will 
be put into “Edit Mode” (see the item below called “Start Editing…”). 

3. “Zoom to Extent of Available TOPO! Maps” 

This item is only accessible when you are in Edit Mode for a layer (see the item below 
called “Start Editing…”). When you choose it, the data frame will be zoomed so that you 
can see the rectangular outlines of all TOPO! maps that are either in the layer or available 
to be added. 

4. “Set Local Directory for TOPO! Metadata Files…” 

Click this item to specify the location on your hard drive that you would like to use for 
TOPO! layers, projection information, and any “raster pyramids” that ArcGIS might 
build for these layers (see ArcGIS documentation to learn more about metadata and/or 
pyramids). The pyramids are the only files that will consume significant amounts of disk 
space (roughly 2 MB per 7.5’ map). NOTE: Changing this setting does not move existing 
TOPO! metadata files, but only changes the default location for new TOPO! layers that 
you create in the future. 

5. “Copy All Maps for this Layer to a Local Directory” 

If you have added maps to a layer from a TOPO! CD-ROM, you can use this option to 
copy those maps to your hard drive. This is useful if you want to have all the maps and 
data stored locally, without requiring the CD-ROM in the future. Once maps are copied 
in this manner, they will be accessed from this local directory, not only for this particular 
layer, but also for all new layers you create that use these maps. 

6. “Help…” 

Choose this item to open this User Guide. 

 

    (continued) 
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Items on the pull-down menu called “Editor”: 

1. “Start Editing” 

Choose this item to add more TOPO! maps to an existing layer (or to remove maps). 
First, specify which layer you wish to edit by selecting it from the “Layer” pull-down list 
on the toolbar. Then, choose “Start Editing” to enter “Edit Mode”. The extension will 
search for TOPO! data on your CD-ROM drives and/or hard drives. Once it has found all 
available data, it will display them using rectangular outlines. Grey rectangles represent 
maps that are not in the TOPO! layer, and red rectangles represent maps that are in the 
layer. Use the ‘Add Maps’ tool and ‘Remove Maps’ tool to toggle maps in or out of the 
layer (see descriptions of these below), then choose “Stop Editing” from the “Editor” 
menu to return to the normal display of maps. 

2. “Stop Editing” 

Choose this item to return to the normal display of maps once you are done editing. You 
will be asked whether you wish to “Save Edits?”. Choose “Yes” to proceed with any 
changes you have made to this TOPO! layer, or choose “No” if you wish to exit without 
saving these changes. Choose “Cancel” to continue editing. 

The “Layer” pull-down list: 

This lists the names of all TOPO! Group Layers you have created in this Data Frame. Choose 
a layer from this list before you click on “Start Editing”. 

The ‘Add Maps’ tool: 

This tool is only available when you are in Edit Mode for a TOPO! layer (see the item above 
called “Start Editing…”). With this tool, click on a grey rectangle that represents a TOPO! 
map that is not currently in this layer, and it will be added to the layer (and now displayed in 
red). To add multiple maps at once with this tool, hold the mouse button down while you drag 
a rectangle the encompasses them all, then release the mouse. 

The ‘Remove Maps’ tool: 

This tool is only available when you are in Edit Mode for a TOPO! layer (see the item above 
called “Start Editing…”). With this tool, click on a red rectangle that represents a TOPO! 
map that is currently in this layer, and it will be removed from the layer (and now displayed 
in grey). To remove multiple maps at once with this tool, hold the mouse button down while 
you drag a rectangle the encompasses them all, then release the mouse. 

TIP: You can switch to other ArcGIS tools while editing a TOPO! layer. For example, you may 
wish to use the Pan and Zoom tools to navigate around the map before you stop editing. 
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6. Contacting National Geographic Maps 
 

For Ordering, General Inquiries, or Technical Support: 

Online at: www.nationalgeographic.com/topo 

By Email: topo@ngs.org 

By Phone: (800) 962-1643 

By Mail: National Geographic Maps 

P.O. Box 4357 

Evergreen, CO 80437-4357 

 

NOTE: Visiting us online is the best way to find out if there is a more current version of this 
software available, to get answers to frequently asked questions, and to get solutions for problems 
that have been reported by other users. 

http://www.nationalgeographic.com/topo
mailto:topo@ngs.org

